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Preface 
 
Welcome to the Oracle Insurance Insbridge Rating and Underwriting RateManager Administrator User 
Guide. This guide describes the features and functionality of the Oracle Insurance Insbridge Rating and 
Underwriting RateManager (RateManager) Tools Menu. RateManager is a component within the Oracle 
Insurance Insbridge Rating and Underwriting (IBRU) System that enables users to manage the product 
definition and modification process, including rating and underwriting logic. The Tools Menu is where the 
majority of RateManager Administrator functions are performed. References to the RateManager User 
Guide, which covers the Modules Menu, will be made periodically.  
 

AUDIENCE 
 
This guide is intended for RateManager system administrators who are tasked with managing system 
features. Users should be familiar with their company’s practices and terminology. Advanced users may 
benefit from having knowledge of their company’s current working rate manual. 
 

RELATED DOCUMENTS 
 
For more information, refer to the following Oracle resources: 
 

● The Oracle Insurance Insbridge Rating and Underwriting Framework Administrator User Guide. 
 

● The Oracle Insurance Insbridge Rating and Underwriting SoftRater Server User Guide. 
 

● You can view these and other IBRU guides on-line at this address: 
 
http://www.oracle.com/technetwork/documentation/insurance-097481.html 

 

CONVENTIONS 
 
The following text conventions are used in this document: 
 

Convention Description 

bold Boldface type indicates graphical user interface elements associated with an 
action. 

Italic Italic type indicates book titles, emphasis, or placeholder variables for which you 
supply particular values. 

Monospace Monospace type indicates commands within a paragraph, URLs, code in 
examples, text that appears on the screen, or text that you enter. 

http://www.oracle.com/technetwork/documentation/insurance-097481.html
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SYSTEM REQUIREMENTS 
 
For minimum operating system and hardware requirements, please see the Hardware Software 
requirements guide. 
 

Manual History 
 
New editions incorporate any updates issued since the previous edition.  
 

Edition Publication 
Number 

Product 
Version Publication Date Comment 

1st Edition P01-775-01 R 4.0 May 2010 New Release Update 
2nd Edition P01-775-02 R 4.0.1 August 2010 Updated Release 
3rd Edition P01-775-03 R 4.1 December 2010 Update Release 
4th Edition P01-775-04 R 4.5 May 2011 Update Release 
5th Edition P01-775-05 R 4.5.1 September 2011 Update Release 
6th Edition P01-775-06 R 4.6 May 2012 Update Release 
7th Edition P01-775-07 R 4.6.1 November 2012 Update Release 
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Chapter 1 

SYSTEM OVERVIEW 
 
Prior to accessing RateManager, you should have received: 
 

● RateManager URL – RateManager can be accessed by going to http://<yourserver>/rm, where 
<yourserver> is the name of the server where RateManager is installed. 

● Username – usernames are required.  
● Password – passwords are required. 
● Subscriber – subscriber information may not be required. 

 
A subscriber  may be a single company, a group within the company, or a single person. If more than one 
subscriber has been set up by the system administrator, you will have to select the subscriber where you 
want to work. If only a one subscriber has been setup, you will not have to select a subscriber. 
 
If you do not know any of this information, please contact your system administrator. 
 

  
If multiple subscribers have been setup, there will 
be a menu for users to select the subscriber where 
they will work. 

A single subscriber only has username and 
password fields. Subscriber information is not  
required. 

 
Logging In 
 
Access to RateManager is gained through a login screen. To login, enter your username and password 
and click LOGIN. Depending on your company setup, you may need to select your subscriber. If a 
company subscriber is required, a menu will be displayed. Select the subscriber you need, and continue 
to log in. 
 
A successful login places you on your Home Tab. 
 
A failed login displays an error message. Please correct any errors and try again. If you cannot log in, 
please contact your system administrator. 
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Help Logging In 
 
If you have forgotten your password, username or need assistance with logging into the system, please 
contact your system administrator. 
 
 
Rights 
 
RateManager uses rights to allow users access to various areas. The type of rights you have will 
determine what you can view, edit, add or delete. There are three types of rights:  
 

● No Access –you cannot enter this area. The fields will be grayed out or not displayed. 
● Read Only – you can view the information but you cannot make any changes. Save, edit or other 

features may be listed on the toolbars or right click menus, but you will not be able to effect any 
changes. 

● Full Access – you can view, edit, add or delete information where applicable. 
 
The system administrator sets group rights. If there is an area you cannot enter or edit, and you think you 
need access, please contact your System Administrator. 
 
 
Logging Out 
 
The Logout option logs you out and closes RateManager. 
 

 
Figure 1 Logging Out  
 
To log out, click FileLogout. If you have any elements open that show a change, you will be asked if 
you want to save. After saving your work, you will be logged out. 
 
 
Internet Explorer 
 
RateManager requires an ActiveX controller. You may be prompted to install this controller when you 
begin to use RateManager. A message bar is displayed at the top of the screen. You can run the ActiveX 
controller from there. If you experience issues with some RateManager screens in Internet Explorer 8 or 
Internet Explorer 9, the ActiveX Control may need to be re-registered. Please contact your system 
administrator for the RateManager for the RateManager_IE7_IE8.exe included in the installation 
download.  
 
To install the Active X Controller, please see the RateManager End User Setup Guide, available on the 
OTN http://www.oracle.com/technetwork/documentation/insurance-097481.html 
 
NOTE: The IBRU system currently requires Microsoft Internet Explorer release 8.0 32-bit or 9.0 32- bit. 

http://www.oracle.com/technetwork/documentation/insurance-097481.html
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RATEMANAGER TABS AND MENUS 
 
RateManager allows for multiple tabs to be utlized. The tabbed authoring interface allows for multiple 
activities to be open across separate tabs without losing any functionality. Each tab functions 
independently. You can view the Program Explorer, then edit a program version, and then create a new 
algorithm without being forced to close the prior tab. 
 
The RateManager tabs follows a familiar model, a fixed top bar menu with four options. Each option 
contains a menu of system features. Each feature opens either a new tab or a popup window. The new 
menus contain the same features that were in previous releases of RateManager. 
 

 
 
The File menu: 
 

• Reload: reloads the page. Use this option when you want to refresh the screen. 
 

• Logout: logs you out of the system. 
 
 

 
 
 
The Module menu: 
 

• Program Explorer: the program explorer holds sublines, folder, programs and program versions. 
Many of the procedures and functions performed under the line of business are found here. 

 
• Testing: opens the testing module. This area allows you to test your rating program during 

development without loading packages. In previous releases, this area was called 
ScenarioManager. 

 
• Impact Analysis: opens the area for batching and data analysis. This area is a combination of 

previous release BatchManager and PricingManager modules. 
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• Releases: allows groups of rating packages to be automatically deployed and loaded to IBFA 
through a release. If you do not have release rights, this option will not be displayed. Please see 
the RateManager Tools User Guide for more information. 

 
• MultiLines: a collection of programs from all lines of business combined with output mappings 

and assigned to execute in sequence that returns a single or multiple results. In previous 
releases, this area was called MultiLines. 

 
• Library: the library is where custom XML files used in mappings as well as imported and 

template programs are stored and managed.  
 
 

 
 
 
 
The Tools menu: 
 

• Manage Lines: opens a screen where administrators can manage lines of business. This is an 
advanced system feature and may not be available to all users. 

 
• Audit: contains the audit logs of system users.  In previous releases, this area was called Logs. 

This is an advanced system feature and may not be available to all users. 
 

• Migrate Work Files: this option migrates the work files from previous releases into the current 
release. This is an advanced system feature and may not be available to all users. 

 
• Security: is where users, user groups and sessions are managed. This is an advanced system 

feature and may not be available to all users. 
 

• Database: this area is for administrators to create backups and deploy updates. This is an 
advanced system feature and may not be available to all users. 

 
• Preferences: brings up the window where you can select the snaps you want to display on your 

Home Tab. For advanced system users, system setup information is displayed. 
 

• Change Password: allows users to change their password. 
 
This guide focuses on the features and functionality in the Tools menu. 
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The Help menu: 
 

• RateManager Help: clicking this option brings up online help. 
 

• RateManager Version: clicking this option brings up system information. 
 
 
Tab Navigation 
 
Multiple tabs can be open at any time. You can move from tab to tab by clicking the tab you want. You 
also can click the tab display icon  in the upper right hand of the screen to see a list of all the open 
tabs. You can navigate to any tab in the list by selecting it. 
 

 
 
 
NOTE: If you have a popup window open, you will have to close the popup before you can click on 

another tab. 

 
   The close tab icon will close the tab you are currently on. If you have any elements open that show a 

change, you will be asked if you want to save. 
 

Home Tab 
 
Once you have logged in, you are on your Home Tab. The Home tab has a control panel that contains 
links to all the major components of RateManager. Additional panels called Snaps also can be added. 
Snaps are modules that contain information or links to elements that you recently worked on. For 
example, if you selected the snap My Recently Opened Programs, you would see a list of the last 10 
programs that you opened. 
 
The Home tab can be customized to contain the information you want to see immediately when you log 
in. The Home tab is always the first tab and cannot be closed. 
 
The Control Panel contains links to all the major components found in the Modules menu. This area 
cannot be removed but can be reduced by clicking the arrow in the upper right hand corner of the panel. 
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The Tools menu does not have a link in the Control Panel. 
 
The RateManager home page displays the current username, subscriber and version at the top of the 
screen. 
 
Access to the pages you are authorized to view or change is gained by selecting the area you want from 
the menu bar or clicking the icon on the Control Panel. Under the Program Explorer, each line of business 
where you have access is displayed. If you have been granted edit privileges, you can add or change 
information. 
 
For more on the Home Tab, please see RateManager Modules User Guide available on the OTN 
http://www.oracle.com/technetwork/documentation/insurance-097481.html. 
 
 
 
 

http://www.oracle.com/technetwork/documentation/insurance-097481.html
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Chapter 2 

MANAGE LINES 
 
The Manage Lines of Business (LOB) screen gives you a snapshot of all the lines of business currently in 
the system and shows if the line is activated or deactivated. RateManager comes with 32 system lines. 
 
Lines of business should be setup prior to creating non-admin users. If you create regular users without 
any lines being activated in the system, you will have to return to the Group Management screen to 
assign permissions. 
 
NOTE:  The Manage LOB screen is available to system administrators only. If you do not have this role, 

you will not be able to perform these actions. 

 
 
Navigating to the Line of Business Screen 
 

1. From the menu tree, expand Tools and select Manage Lines.  
 

 
 
 

2. This brings up the Manage LOB screen. 
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Figure 2 Manage LOB Screen 
 
 
Manage LOB Menu Bar 
 
The menu bar at the top of the screen allows you to: 
 

  New starts the process of creating a new line of business. See Creating New Lines of 
Business for more information. 

 
  Opens the Edit Line of Business Info screen for the currently selected line of business.  

 
Show listing for lines: Allows you to view LOBs by activation status. Select the status you want 
to view from the drop down menu.  
 

- ALL: Selecting ALL displays all of the lines currently in the system. 
- Activated: Selecting activated displays only the currently activated lines. 
- Deactivated: Selecting deactivated displays only the deactivated lines 

 
All is the default selection. If you choose another selection, the screen refreshes with your choice. 
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Manage LOB Fields 
 
Lines are listed by ID number. The total number of lines in the system, both activated and deactivated, is 
displayed on the bottom of the screen. 
 

ID:  The unique identifier assigned to each line of business. Once assigned, these numbers 
cannot be changed. 

 
Description:  The name of the line of business. Names must be unique. Duplicates are not 
allowed.  

 
Activated:  A check in this column indicates that the line of business has been activated and is 
ready for use. 

 
Type:  Shows whether the line is:  

 
● System built. System built lines of business are the standard lines that were included in 

the original download of the system. System lines cannot be deleted. 
 
● Custom built. Custom built lines of business are lines that were added later. Custom line 

can be deleted. 
 
 
Manage LOB Functionality 
 
The Manage Line of Business screen allows you to do the following: 
 

● Create a New Line of Business 
● Edit a Line of Business 
● Activate a Line of Business  
● Deactivate a Line of Business 
● Remove All Programs from a Line of Business 
● Delete Custom Lines of Business 

 
NOTE:  System lines of business cannot be deleted. If there is a System line of business you no longer 

need, you can deactivate it. This stops the line from being listed and being available. Custom 
lines can be deleted. 

LOCALE 
 
Prior to creating a new line or activating a line, you should have the locale you want to use in mind. 
Locale is defined as the unique attributes of a location including formatting of dates and numbers. The 
default locale, including a date and number format, is the locale used by the server where the IBRU 
system was installed.  
 
The IBRU server locale is used as the default locale for every LOB. The LOB locale can be changed to 
another locale. The default locale for the LOB is the default locale for every program in that LOB, 
regardless of subline. The program locale can be updated to another locale. The locale used by the 
program, either another local or the default locale, is the locale that will be used in rating.  
 



Chapter 2 – Manage Lines 

18 

Selecting a Locale 
 
There are two places where you can select the locale: 
 

● LOB level 
● Program level: For more on Program Locale, please see the RateManager Modules Volume 1 

User Guide.  
 
 
Select a Locale at the LOB Level 
 
The New Line of Business screen and the Edit Line of Business screen contain a drop down of available 
locales. The default locale is the locale used by the sever where the IBRU system is installed. A Locale 
must be selected. You can leave the default or select a different locale when you activate a system LOB, 
edit an LOB, create a new LOB, create a new program, or edit the program properties. 
 
If you do not select a locale, the default will be used. The Date Mask, the Decimal Symbol, and Digit 
Grouping Symbol are automatically filled with the defaults. These values can be updated and you can 
type in an alternate value if you choose. You must have a value in the Date Mask, Decimal Symbol, and 
Digit Grouping Symbol fields.  
 
The values set at the LOB level serve as the default locale to every program created in the line regardless 
of subline. If the program requires a different local, you can change the locale at the program level. 
 
To verify a locale, open the Edit the Line of Business screen. The selected locale for the LOB is listed 
here. 
 
 
Updating a Locale 
 
Updates to Locale at the LOB level will affect new programs. Existing programs will not be affected by 
updates. Existing programs already have a locale set at the program level. 
 
WARNING:  Changing date and number formats may result in programs not running properly. Global 

elements that have been created as one type of date and number format may not function 
as expected with another date and number format. Date and number formats should be 
consistent through the program. 

 

Date 
 
Date formats are displayed as entered and will be executed and evaluated as you expect during rating. 
Date formats are carried through to any new versions or revisions. 
 
Dates must contain: 
 

● 2 digit Month entry MM 
● 2 digit Day entry DD 
● 4 digit Year entry YYYY or a 2 digit Year entry YY 
● One of 3 separators minus sign ( -  ), period ( . ) or slash ( / ) Special characters are not allowed. 

The list of special characters can be found the RateManager Modules Volume 1 User Guide.  
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Date formats are defined in the LOB. Any program in the line will use the defined format. A different 
format can be entered in the program. 
 

● Date formats can be in any combination of the mandatory fields, for example MM/DD/YYYY.  
 

● Date format is case sensitive. You must you capital M, D and Y.  
 

● A separator must be used, i.e. slash( / ) MM/DD/YYYY, minus sign ( - ) DD-MM-YYYY, or period ( 
. ) MM.DD.YYYY. 

 

Number Formatting 
 
Number formatting refers to the decimal and digit separators found in common number formats, for 
example, 1,000.00 or 10.000,00.  
 

● Decimal Symbol:  The decimal symbol indicates the integral part of a number from the fractional 
part. For example, 10.25 (using a period as the decimal symbol) or 8,50 (using a comma as the 
decimal symbol). 

 
● Digit Grouping Symbol:  The digit grouping symbol indicates the symbol that is used to show 

the thousands separator. For example, 1,000 (using a comma as the digit grouping symbol) or 
1.000 (using a period as the digit grouping symbol). 

 
The digit grouping symbol is used for validation purposes and not for display purposes. 

  
 
Number formats are defined in the LOB. Any program in the line will use the defined format. A different 
format can be entered in the program. 
 

● Most separators, i.e. comma ( , ), period ( . ), or space (  ) are allowed. The special characters 
apostrophe ( ‘ ), pound ( # ), ampersand ( & ), quote ( “ ), less than (<), and greater than (>) are 
allowed. A complete list of special characters can be found the RateManager Modules Volume 1 
User Guide. 

 
● You cannot use the same separator for the decimal and digital. The separators must be different. 

 
● Only one separator per entry. You cannot enter a space (  ) for the millions separator and then a 

comma ( , ) for the thousands separator. You have to select either the space or the comma. 
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Creating a New Line of Business 
 
Custom lines may be added at any time by a RateManager administrator. LOB ID numbers are entered 
manually. This allows you to match any LOB that may be Custom from the Library. LOB ID numbers must 
fall between 100-250. 
 
 
To Create a New Line of Business 
 

1. Navigate to the Line of Business screen. 
 

2. Click New. A New Line of Business popup is shown. 
 

 
Figure 3 Entering a New Line of Business 
 

3. In the new line of business popup, enter an ID number. The number must be an unused number 
between 100 – 250. If the number is out of range or being used, you will receive an error 
message. This number cannot be changed after you save. 
 

4. Enter a name. The name may consist of up to 40 characters.  
 

5. Select the locale.  
 

6. If needed, select a date mask. This date format will be used as the default for all programs 
created within that line of business. 
 

7. Select the Decimal Symbol. This is the default decimal symbol that will be used for all programs 
created within that line of business. 
 

8. Select the Digit Grouping Symbol. This is the default digit grouping that will be used for all 
programs created within that line of business. 
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9. By clicking the Activated checkbox, the line of business will be activated after saving. 
 

10. Click Save. The line of business, if activated, should show in the Program ExplorerProgram 
Folders navigation bar. If it does not appear, click the “Sync Menu” button in the upper portion of 
the navigation bar. This is for Admin Users only. All groups except Administrators will be denied 
access to any new line of business. You must allow the group access before any program options 
are available to them. 
 

11. Navigate to ToolsSecurityGroup Management to set permissions. This allows groups access 
to view or edit variables, algorithms and other program options. 
 

NOTE:  Adding a line to group permissions needs to be done for a first time activation only. If you 
deactivate and then activate again, you will not need to reset permissions. 

 

 
Figure 4 Setting Security for New Lines of Businesses 
 
12. Select the group that needs access to the new line of business.  
 
13. Click on Rights. A Group Rights screen is displayed. Expand out the new line of business.  
 
14. Place a check in all the boxes where the group requires access. Click Save. Users in that group can 

now view and use the selected options. For more on user groups and rights, see Group Management. 
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Editing a Line of Business 
 
Any line of business may be edited at any time.  
 

1. Navigate to the Line of Business that you want to edit. 
 

 
Figure 5 Selecting a LOB to Edit 
 

2. You can double-click the line of business you want to edit or select it and click Edit. You also can 
right click and select Edit from the menu. The Edit LOB popup opens, allowing you to edit the line 
of business.  

 

 
Figure 6 Editing an LOB 

 
3. Make any necessary changes. Every field can be edited.  

 
4. When you are finished, click Save. The line of business screen refreshes with the changes you 

made. Click Close to go back to the Manage LOB screen without saving any changes.  
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Activating and Deactivating a Line of Business 
 
Any line of business may be activated or deactivated at any time. Activating a line of business displays 
the line and all associated programs on the Program ExplorerProgram Folders navigation bar. 
Deactivating a line of business removes the line and all associated programs from the Program 
ExplorerProgram Folders navigation bar. 
 
You can activate and deactivate a line as many times as you need. Permissions and contents are not 
removed when a line is deactivated. If you reactivate, the permissions and contents will be the same. 
 

1. Navigate to the Line of Business that you want to activate or deactivate. 
 

2. Right click to get the menu. For a System line, a deactivated line has two right click menu 
options; an activated line has three menu options. For a Custom line, a deactivated line has three 
right click menu options; an activated line has four menu options. 

 

 
Figure 7 Selecting a LOB to Activate 

 
3. To activate: Click Activate. The screen refreshes and the line of business that you activated is 

now displayed on the Program ExplorerProgram Folders navigation bar. You also can activate 
a line of business by entering the edit screen and selecting Activated. 
 

 
Figure 8 Selecting a LOB to Deactivate 

 
4. To deactivate: Click Deactivate. The screen refreshes and the line of business that you 

deactivated is not displayed on the Program ExplorerProgram Folders navigation bar. 
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Removing All Programs from Line of Business 
 
Any line of business can have all programs removed. Proceed with care, this action cannot be undone 
and will remove all programs under that line. The sublines remain in place and all globals under each 
subline also remain. If you are unsure, you can deactivate a line of business. This removes the programs 
from usage but not from the system. If you want to remove the subline, use the Clear Subline option on 
the Program Explorer. 
 

1. Navigate to the Line of Business where you want to remove all programs. 
 

2. Right click  and click Remove All Programs. A warning message will be displayed. Click Yes to 
remove all programs. Click No to cancel the action. 

 

 
Figure 9 Removing All Programs from an LOB 

Deleting a Custom Line 
 
Custom lines can be deleted at any time. All associated contents for the line are deleted as well. Please 
verify this is the action you want to take. This action cannot be undone. Two warnings are given. You will 
need to refresh the screen to see that the line has been deleted. 
 

1. Navigate to the custom Line of Business you want to remove. 
 

2. Right click to get the menu. 
 

3. Click Delete. A warning message is displayed. Click OK to remove the line. Click Cancel to 
cancel the action. A second warning message is displayed. Click OK to remove the line.  

 

 
Figure 10 Removing All Programs from an LOB 
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Chapter 3 

AUDIT 
 
RateManager can keep an audit log of user activity. Audit logs contain information such as action 
performed, user ID, date and time stamp. Audits set to high will also track adding a user, editing a user 
and deleting a user. Audit logs also can include program information such as program ID, program 
version and line of business as well as element information. 
 
The Audit tab contains a list of audits logs. The audit log feature has to be enabled at the group level. On 
the Group Management tab, ToolsSecurityGroup Management, select the group where you want to 
apply auditing. There are three options for auditing the group:  
 

● None: No auditing is done. 
● Normal: All saves and deletes are logged. 
● High: All new, creates, changes, saves, and deletes for the group are logged. 

 
If the group(s) has high auditing, more audit logs are created and you will have more types of actions you 
can filter on. 
 

 
Figure 11 Audit Tab 
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Navigating to Audit  
 

1. Select ToolsAudit. 
 

2. This opens the Audit tab. 

FUNCTIONALITY 
 
The Menu Bar is located at the top of the tab. The menu bar contains the functions you can perform on 
this tab. 
 
 
Functions: 
 

 

Filter:  Opens up the filter option. You can select fields to filter on. The entries you 
make in the filter option will be the results returned. The results are displayed in the 
main body of the tab. Any field that does not match is not displayed. Filters are removed 
when you exit the tab or re-enter the filter option and remove the filter. 

 
Audit Report: Opens up a full Audit Report for the audits currently being displayed. 
Audits that have been filtered out are not displayed. 

 

Purge All: Purges all audits currently displayed. Results can be filtered for purging. If 
you filter audits, only the audits that meet the filter criteria are displayed. These audits 
will be removed if you select to Purge All.  If you select to purge all without a filter, every 
audit is deleted. 

 Refresh: Refreshes the list of audits. 

FIELDS 
 
The main body of the tab displays the logs that have been created since the last purge. There are five 
fields in the main body of the Audit tab.  
 

Action: The action performed.  
 
Line: The line of business. No Line means that this was a system action, for example, logging in 
or out of the system. 
 
Program: The name of the program where the action took place. No Program name means that 
this was a system action. 
 
Version: The program version number where the action took place. No Program Version number 
means that this was a system action. 
 
Version Name: The program version name assigned to the program. This is an optional field and 
may not have an entry. 
 
Date: The time stamp of when the action tool place. 
 
Control Number: Displays any Change Control information. 
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NOTE:  If you have Auditing on and no results are being displayed, verify that the Insbridge Message 
Service is running. Audit logs may not be displayed if the Message Service is not running. 

 
 
Right Click Menu 
 
There is a right click menu available on every audit log. 
 

 
Figure 12 Audit Listing Right Click Menu 
 
The right click menu contains two options: 
 

● View Audit Report: This option displays the audit report for this audit log only, in a printable 
form. If you do not need to print out an audit report, double click the log and view the audit details 
at the bottom of the screen. 

 
● Delete Audit: This option deletes the selected audit log only. Use this feature to delete logs that 

are not removed in a purge, such as purge logs and audits with Change Control entries. 
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FILTERING 
 
Filtering allows you to filter audit logs by specific criteria. When you select a filter, any audit logs with that 
criteria will be returned to the report. Results are listed newest to oldest. The results can then be used to 
create an Audit Report or be purged. 
 

 
Figure 13 Filter Selection 

 
Action: You can filter by words found in the action description. For example, Login, Save, Delete, or 
Control. You do not have to enter the entire phrase. For example, you can enter “New” and any action 
description with the word “New” in it will be returned. Your filter options depend upon the level of auditing 
the group has. If your group(s) has high auditing, more audit logs are created and you will have more 
types of actions you can filter on. 
 
Line Desc: You can select an active line of business from the drop down menu or you can click the 
Custom link to enter in your own description.  
 
Program ID: You can enter in the exact program ID. Only exact matches will be returned. 
 
Version Name: You can enter in the exact program version name. Be aware that program version names 
are not required and are not unique. If you enter in 1, you may get many results for program version 1 
from multiple lines of business and multiple programs. Only exact matches will be returned. 
 
Program Ver: You can enter in the exact program version. Be aware that program versions are not 
unique. If you enter in 1, you may get many results for program version 1 from multiple lines of business 
and multiple programs. Only exact matches will be returned. 
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User FirstName: You can enter in a user first name up to 20 characters. Only exact matches will be 
returned. 
 
User LastName: You can enter in a user last name up to 20 characters. Only exact matches will be 
returned. 
 
From Date: Dates must be entered in yyyy-mm-dd format. Only entering in a From Date will return audit 
logs from that date until current. Date ranges can be returned by entering in both and from and to dates. 
 
To Date: Dates must be entered in yyyy-mm-dd format. Only entering in a To Date will return all audit 
logs from the beginning of the audit log until that date. Date ranges can be returned by entering in both 
and from and to dates. 
 
Control Number: You can enter in the exact Change Control number or tag used when creating the new 
revision. This is helpful if you want to make sure all changes were done against a particular change order. 
You do not have to go into each element to search. You can come here, enter in the change control 
identifier and view the list here. You can also do an action filter by the word Control to get a listing of all 
change controls.  
 
 
To Set Filtering 
 
NOTE:  Line of Business 0 is MultiLines. To search for MultiLines items, you must do a custom search. 

Change the Line Desc field to custom and enter in a 0. Click OK to search. 

 
1. On the Audit tab, click FILTER. This pulls up a filter screen where you can enter criteria that will 

narrow your audit results.  
 

● You can choose one or more filters.  
● Filters remain in place until your remove them or leave the tab. 
● To clear a filter, click the Clear button. After you clear a filter, all Audit Logs will be 

returned. 
 

2. After you have entered your filters, click OK to view your results. 
 

 
Figure 14 Filtered Audit Listing Results 



Chapter 3 – Audit 

30 

AUDIT REPORT 
 
An audit report for all audit logs currently displayed on all pages by filter criteria can be produced. If you 
want an Audit Report for all audit logs, make sure the filter has been cleared. If you want an audit report 
for a specific type of audit log, make sure to filter by those criteria. For Example, if you want the audit logs 
from a particular day forward, then enter that day in the From Date on the Filter. All the audits from that 
day and forward will be listed. The audit report is a maximum of 15 pages. 
 

 
Figure 15 Audit Report 
 

Creating an Audit Report 
 
To create an Audit Report, enter in the criteria you want to filter by and click Audit Report. Reports are 
displayed in the Insbridge Document Viewer. These reports are read-only. Reports can be saved to your 
local hard drive or network or printed. No editing can be done on the Insbridge Document Viewer. 
 
NOTE:  When you do a “Save As” from the Insbridge Document Viewer, you should rename the file. By 

default, when you go to save a file in the Insbridge Document Viewer, everything is named 
“InsbridgeDocument”. It is recommended that you re-name the file. 



Chapter 3 – Audit 

31 

Report Details 
 
The report contains details for each of the audit logs included, starting with the newest. Each log has 
action information, defining the action taken, the user, and the date. Program information, such as LOB, 
program, program version, and program ID, may be included. If applicable, element/item information 
including description, revision and ID may be included. 
 
NOTE:  OBI Publisher must be installed and running in order for Program and Program Version Reports 

to be displayed. If you receive an OBI Publisher error, please contact your system administrator. 

 
 
Audit Preview 
 
To view a specific audit, double click the line. The audit report details are displayed in Preview Window 
located in the lower portion of the tab. 
 

 
Figure 16 Audit Log Preview Screen 
 
The preview window can be sized by dragging the separation bar between the audit list and the preview 
window. The preview window will update to show the currently selected audit log. 
 
NOTE:  If logs are not displayed, please verify that the Insbridge Messaging Service is on. If the Insbridge 

Messaging Service is off, logs will not be displayed. 

 
Individual logs can be viewed or deleted. 

PURGING AUDIT LOGS 
 
Audit logs that do not have a change control can be purged at any time. Purge All removes all audit logs 
currently displayed on all pages by filter criteria. For example, if you have run a filter for all logs created 
on May 23, 2012, the screen will display all logs created on that day only. The logs may consist of one 
page or many pages. If you click Purge, all logs for May 23, 2012 without change controls will be purged. 
No other logs will be purged. To view remaining logs, clear the filter. 
 
If you want to purge all audit logs without change control, do not place a filter on the list. If you only want 
to purge selected items, place a filter on the list. Purge will only remove the audit logs that are displayed 
on the Audit Listing screen.  If you want to remove one audit, use the right click menu to delete. 
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To Purge Bulk Audits 
 

1. If you have a specific audit type or group of actions you want to remove, set a filter for the bulk 
audits you want to remove. 
 

2. When the audits you want to remove are displayed, click Purge All. 
 

 
Figure 17 Purging an Audit List 

 
3. Click OK to remove the all audits without change control currently displayed. Click Cancel to 

return to the previous screen. 
 
NOTE:  Purge Logs and Change Control Audit logs are not purged in bulk. These logs must be deleted 

one at a time using the right click menu. 

 
 
To Delete One Audit 
 

1. To remove one single audit that is no longer required, highlight the audit. Audits with change 
control can be deleted using Delete Audit.  
 

2. Right click and select Delete Audit from the menu. 
 

 
Figure 18 Purging an Audit List 

 
3. Click OK to remove the log. Click Cancel to return to the previous screen. 
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Chapter 4 

MIGRATE WORK FILES 
 
This feature migrates work files from a previous version of RateManager to release 4.5. Work files are 
rating, pricing, mapping, and template files used in various areas of RateManager such as Impact 
Analysis, Library, and Testing. Migrating files allows users to access work files that were available in a 
previous release of RateManager. If you do not migrate work files from previous versions, users will not 
have access to them. 
 

MIGRATING FILES 
 
Prior to migrating files, please create backup copies of the files to be migrated. This requires access to 
the server were RateManager has been installed.  
 

 
Figure 19 Location of WorkFiles 
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The location of the files to be migrated and the exact file name depend upon what version of 
RateManager you want to migrate. There are two possible locations. 
 
For Release 3.12 and earlier:  
 

● File Name: WorkFiles 
● Location: \Program Files\InsBridge\Webs\RMxxx\WorkFiles 

 
Where xxx is the version number, i.e. 310, 311, 312 

 
For Release 3.13:  
 

● File Name: Workfiles 
● Location: \Program Files\Oracle\IGBU\Insbridge\Webs\RM313\Workfiles 

 
Copy all work files for every version to be migrated and store in a safe location. In the unlikely event that 
an error with the migration occurs, you will have backup files that you can place directly in the 
RateManager (RM4) Workfiles location or restore to the previous version. 
 
WARNING: Workfiles should be migrated after the initial upgrade has been run. Running the Migrate 

function after users have accessed the system may result in 4.5 Workfiles being overwritten. 

Performing the Migration in RateManager 
 
This migration process moves rating, pricing, mapping, and template files from a previous version of 
RateManager to the current RateManager version. You can select one version that you want to migrate. If 
you have more than one version to migrate, you must perform the migration manually. Please refer to the 
Installation and Upgrading Guide for instructions.  
 

1. Select ToolsMigrate Work Files. A separate screen is displayed. 
 

 
Figure 20 Migrating Work Files 
 

2. RateManager determines the possible version to migrate. Select the version you want to migrate. 
Only work files from the selected version will be migrated. 
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3. Click Migrate. 
 

 
Figure 21 Confirming a Migration 
 

4. Say Yes to migrate. If you are unsure about the action you want to take, click No to stop the 
migration process. 

 
The migration will begin. This process could take a few minutes to complete. When all files have been 
migrated, an information notice will be displayed. 
 

 
Figure 22 Successful Migration 
 

5.  Say OK to close the screen. 
 
 
Manual Migration 
 
A manual migration must be performed under select circumstances. All versions must be on the same 
server. If you are working with two separate machines, you must perform the migration manually. A 
RateManager migration will perform a copy and paste of the WorkFiles on the server then the previous 
versions WorkFiles will be deleted. This means that the version you select to be migrated will have the 
WorkFiles deleted from the server. This cannot be reversed. Make sure this is the action you want to take. 
 
If you have more than one version where you want to migrate files, you will have to perform the migration 
on the server. DO NOT USE RATEMANAGER TO MIGRATE MULTIPLE VERSIONS. Only one version 
can be migrated. If you attempt to migrate more than one version, you will write over any data with the 
version that you are migrating. For example, if you migrate version 3.12 and then migrate 3.13, any 
information from 3.12 will be written over with the information from 3.13. If you have more than one 
version to migrate, you must perform the migration directly on the server. 
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Verifying Migrated Files in RateManager 
 
Migrated files are available in the same areas.  
 

 
Figure 23 Verifying File Migration in RateManager 
 
To verify that work files from a previous version have been migrated, enter an area where these files 
would be used, such as the Library tab.  
 
The tab refreshes with all available files. Your files from previous versions will be listed. 
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Verifying the File Migration in the Server 
 
Migrated files will be moved from previous releases into the updated RM4 Workfiles location.  
 

 
Figure 24 Verifying File Migration at Server Level 
 
You can verify that files have been moved by looking in the  
\Program Files\Oracle\IGBU\Insbridge\Webs\RM4\Workfiles folder.  
 
Work Files can be moved manually. Please refer to the Installation and Upgrading Guide for instructions. 
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Migration Messages 
 
If the migration has already been done, a message is displayed. 
  

 
Figure 25 Migration Already Performed 

 
If the migrating tool does not find any files to migrate, a message is displayed. 
 

 
Figure 26 No Files to Migrate 
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Chapter 5 

SECURITY 
 
Any administrator may configure RateManager security settings. Usernames and groups can be created 
and system rights assigned. Groups can be created to grant users access to specific lines of business 
and specific screens within that line of business (variables, algorithms, etc.), with or without write access. 
Groups also can be given access to specific modules, Testing or Impact Analysis. 
 
Security can be found on the Tools menu. There are three options you can select: 
 

● User Management 
● Group Management 
● Session Management 

USER MANAGEMENT 
 
The user management tab allows an administrator to add, edit and delete users. This portion of 
RateManager is only available to users who are members of the Administrator group. 
 

 
Figure 27 User Management Screen 
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From here, you can: 
 

● Add a User 
● Edit a User 
● Delete a User 
● Reset a User Password 

 
Company Administrator is the only user in a new system. All other users must be created. The Company 
Administrator cannot be deleted nor have their rights edited.  
 
 
Navigating to User Management  
 

1. Select ToolsSecurityUser Management. 
 
2. This opens the User Management tab. 

FUNCTIONALITY 
 
The Menu Bar is located at the top of the tab. The menu bar contains the functions you can perform on 
this tab. 
 
 
Functions: 
 

 New:  Opens up the Create User tab where new users can be added to the system. 

 
Edit: Opens up the Edit User tab where user information can be updated and user 
password reset. 

 Delete: Deletes the selected user. 

 Refresh:  Refreshes the list of users. 

FIELDS 
 
The main body of the tab displays the users that have been created. There are three fields in the main 
body of the User Management tab. 
 

Name: The first and last name of the user.  
 
Contact Info: The phone number and email address of the user. The email address will be 
hyperlinked, allowing you to create an email for this user. 
 
Last Login: The time stamp for the last date and time the user logged into the system. 
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ADDING A USER 
 
New users can be added from the Add User tab. All new users will be assigned the default password, 
password. New users should log in as soon as possible and change their password. 
 
There are two icons and two buttons located on the tab. 
 

 
Required:  A red asterisk indicates that this field is required. You cannot save your 
entry unless all the required fields are complete.  

 Information: Click the information icon to see more information about the entry. 

 
Select Arrow Move Left: The column on the right lists the available groups. The Select 
Arrow Move Left moves the selected group over to the left side column. Upon saving, 
the user will belong to that group.  

 
Select Arrow Move Right: The column on the left lists the group(s) the user is currently 
a member of. The Select Arrow Move Right removes the selected group over to the right 
side column. The user will no longer belong to that group.  

 
Save: Saves your entry. The Save option is located in the lower right hand corner of the 
tab. 

 
Cancel:  Cancels any changes and returns you to the User Management tab. The 
Cancel option is located in the lower right hand corner of the tab. 

 
 
To Add a New User 
 
NOTE: Prior to creating a user, make sure you have your user groups created. 

 
 

1. Navigate to the User Management tab. 
 

2. Click New to open the Add User tab. 
 

3. Select the Group(s) the new user will belong to by selecting a group or groups from the Select 
Groups list and then clicking Select Arrow – Move Left.  Upon saving, the user will belong to that 
group. 

 
4. Select the Company the user belongs to from the drop down listing. 
 

Subscriber information may be needed by users when logging into the system. If more than one 
subscriber was created, users must be directed to the subscriber where their logins were created. 
Subscriber information is necessary for custom XML creation and testing and is also needed for 
Libraries. 
 
If you have not created subscribers in IBFA, you will not be able to assign users to a company. 

 
5. Enter a First and Last name for the user in the appropriate text boxes. 
 
6. Enter a Username for the new user. The username must be at least six, but fewer than twelve, 

alphanumeric characters and can include an underscore (_) or period (.). 
 
7. Enter a Department for the user. 
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8. Select whether the new user is a Network User by selecting True or False from the drop down.  
 

9. Optionally, enter a Phone Number and Email Address for the new user. 
 

10. If you want the user's password to expire, click the box next to Password Expires. The 
Preferences screen contains the number of days required for a password change. 

 
11. When you are finished, click Save. The user is added to the system and the user list is updated. 

The new user can now log in using the username you assigned them and the default password, 
password. 

 
12. The user should change their password the first time they log in. See Changing Your Password 

for more information. 
 

 
Figure 28 Adding a New User 
 
Network Users 
 
The network user option (if set to true) is to be used in conjunction with the IBRU portal. 
 
If set to True, network user’s credentials (username and password) are validated using Windows 
Authentication Tokens. The username in RateManager must match the network user ID. Users can 
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access RateManager using the IBRU Portal. Users will need the IBRU URL to access RateManager via 
the portal. They will not be required to enter login information at the RateManager login screen.  
 
Please see the IBRU Portal Configuration Guide for instructions on setting up a portal.  
 
If set to False, users must enter a valid username and password via the RateManager login screen. 
Users will need their username and password along with the RateManager URL to access RateManager. 
Users set up with a False Network User can still access the IBRU portal. They will be required to enter 
their login information when accessing RateManager. 
 
 
Removing a User Group 
 
To remove a user from a group, select the Group(s) the user will be removed from and click Select 
Arrow Move Right. Upon saving, the user will no longer belong to that group. 

EDITING A USER 
 
This section allows an administrator to change a user's information such as their email address or phone 
number. It also allows for a user’s password to be reset. 
 
 
To Edit a User 
 

1. Navigate to the User Management tab. 
 

 
Figure 29 User Management for Editing a User 
 

2. Select the user you want to edit and click Edit. You also can edit a user by double-clicking their 
name.  

 
3. This opens the Edit User tab. This screen is similar to the Add User tab and all information can 

be edited, with the following exception: the reset password option. 
 



Chapter 5 – Security 

44 

4. When you have finished making changes, click Save to update the user's information and refresh 
the user listing. If you do not want to save your changes, click Cancel. 

 
 
Resetting User Passwords 
 
You have the option to reset a user's password. If a user forgets their password, you can reset it on the 
Edit User tab. 
 

1. Navigate to the User Management tab 
 

2. Select the user whose password you want to reset and click Edit. This opens the Edit User tab. 
 

3. Scroll to the bottom of the tab and check the reset password box. The user's password is reset to 
the default password, password. 

 

 
Figure 30 Resetting a Password 
 

4. Click Save to save your entry. 
 
The user should change their password the next time they log in but will not be required to do so. 
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DELETING A USER 
 
If a user is no longer needed, they can be deleted. Any user at any time can be deleted. Only the Admin 
user cannot be deleted. 
 
 
To Delete a User 
 

1. Navigate to the User Management tab. 
 

2. Select the user you want to delete and click Delete. 
 

 
Figure 31 User Management for Deleting a User 
 

3. You will be asked to confirm deletion of the user. 
 

 
Figure 32 Confirmation Message for Deleting a User 

 
4. Click OK to delete the user and refresh the user listing. Click Cancel to return to the user listing 

without deleting the user. 
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GROUP MANAGEMENT 
 
The group management tab allows an administrator to add, edit, and delete user groups. RateManager 
groups are used to assign rights to a set of users. You must create groups prior to creating users. 
 
For example, you may have one group called Testers that can only access the Testing module and 
another group called AutoLoaders that only has access to the auto line of business. 
 
The Admin group is a default group and will be the only group in a new system.  This group cannot be 
deleted or edited or have their rights edited. All other groups must be created. The Admin group is the 
only group that has access to the Security module of RateManager.  
 

 
Figure 33 Group Management 
 
From here, you can: 
 

• Add a Group 
• Edit a Group 
• Edit a Group's Rights 
• Delete a Group 
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Navigating to Group Management  
 

1. Select ToolsSecurityGroup Management. 
 
2. This will open the Group Management tab. 

FUNCTIONALITY 
 
The Menu Bar is located at the top of the tab. The menu bar contains the functions you can perform on 
this tab. 
 
Functions: 
 

 
New: Opens up the Add Group tab where new groups can be added to the system and 
auditing levels can be set.  

 Edit: Opens up the Edit Group tab where group information can be updated. 

 
Delete: Deletes the selected group. Before deleting a group, you must remove all 
members from the group. 

 Rights: Opens the Rights screen where you can manage group’s rights. . 

 Refresh: Refreshes the list of groups. 

FIELDS 
 
The main body of the tab displays the groups that have been created. There are four fields in the main 
body of the Group Management tab.  
 

Name: The name of the group. 
 
Description: A description of the group. 
 
Location: The location entered for the group. 

 
Users: The number of users in this group. 

ADDING A GROUP 
 
New groups can be added from the Add Group tab at any time.  There are two steps to creating a group: 
 

• Step 1: Add the Group This step creates the group and allows you to add information about the 
group. The step is performed on the Add Group tab. 

 
• Step 2: Assigning Group Rights This step defines the permissions this group will have. This 

step is performed on the Group Management tabRights screen. 
 



Chapter 5 – Security 

48 

On the Add Group tab, there are two icons and two buttons located on the tab. 
 

 
Required:  A red asterisk indicates that this field is required. You will not be allowed to 
save your entry unless all the required fields are complete. 

 Information:  Click the information icon to see more information about the entry. 

 
Save:  Saves your entry. The Save option is located in the lower right hand corner of 
the tab. 

 
Cancel:  Cancels any changes and returns you to the User Management tab. The 
Cancel option is located in the lower right hand corner of the tab. 

 
 
To Add a Group 
 

1. Navigate to the Group Management tab. 
 

2. Click New to open the Add Group screen. 
 

 
Figure 34 Adding a Group 
 

3. Enter a Name for the new group. The name can be any combination of alphanumeric characters, 
with one to fifty characters. Blanks, periods, underscores, etc. are not allowed. 
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4. Optionally, enter a Description, Location and Email address for the new group. 

 
5. Check if you want Auditing for this group.  

  
6. When you are finished, click Save. The group is added and the group list is updated. Users can 

now be assigned to the group through User Management. 
 
 
Auditing 
 
Auditing is set at the group level and applies to all members of the group. If a user is assigned to more 
than one group, auditing will apply to the group(s) that has it activated.  
 
There are three levels of auditing: 
 

1. None: Auditing is not tracked for the group. 
 

2. Normal: All saves, and deletes for the group are tracked. 
 

3. High: All new items, saves, and deletes for the group are tracked. 
 
If auditing is set to normal or high, a log is kept for changes and actions done by each member of the 
group. If auditing is set to none, no logs are kept. Audit logs are displayed in the Audit tab. 
 
Auditing is also displayed in the View History report. The View History report contains audit logs for the 
users who have auditing in place. For example, if your RateLoading group has auditing set to high and 
your BA group has no auditing, the View History report will only contain the actions done by the 
RateLoading group. Since the BA group did not have any auditing turned on, none of their changes or 
actions will be listed in either the Audit Module or the View History report. The level of auditing will 
determine the detail of the View History report. 
 
Auditing can be set for any group, including admins. If auditing is set to high for the admin group, logs are 
created for adding, editing, and deleting users. Logs are also kept for adding, editing, and deleting user 
groups.  
 
Session logs are kept for all users and record when users log in and log out. 
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Group Rights 
 
Group Rights are broken into areas and lines of business. You can allow users access to the entire 
system or just certain modules. You also can restrict users from performing certain actions, such as 
packaging or creating folders. 
 

User Actions 
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Permissions to Grant 
RateManager Domain Admin 

Line Management – Allows users full access to manage lines. X X   
Subline Management – Allows users full access to manage sublines. X X   

RateManager MultiLines 
Programs –  X    

Write Access –   X   
Scenario –  X    

Write Access –   X   
MultiLines Mapping –  X    

Write Access –   X   
Inputs –  X    

Write Access –   X   
MultiLines – X    

Write Access –   X X  

RateManager Testing 

Testing Module – Allows users full access to the testing module. X X   

RateManager Package Admin 

Program Export – Allows users to export programs in the Library. X X   
Program Import – Allows users to import programs in the Library. X X   
Release Management – Allows users to access the Releases Module. X X   

Database Support  
Backups – Allows users to create database backups within RateManager. X X   
Restores – Allows users to restore databases within RateManager. X X   

LOB  
Variables –  X    

Write Access –   X   
Algorithms –  X    

Write Access –   X   
Driver Assignment – AUTO LOB ONLY X    

Write Access –   X   
Sequencing –  X    
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Write Access –   X   
Output Mapping –  X    

Write Access –   X   
Inputs –  X    

Write Access –   X   
Categories –  X    

Write Access –   X   
Program Management –  X    

Write Access –   X X  
Lock Admin –     X 

 
Permission to Grant Definitions 
 
There are six areas: 
 

1. RateManager Domain Access: Allows users to manage lines and sublines. 
a. Line Management: Users will be able to create, edit, activate, deactivate, delete the line 

and delete all programs in the line. The permission may be needed by users who work 
with templates. 

b. Subline Management: Users will be able to create, edit, activate, deactivate, delete the 
line and delete all programs in the line. The permission may be needed by users who 
work with templates. 

 
2. RateManager MultiLines: Allows users to work in the MultiLines Module.  

a. Read permissions are granted to all areas in MultiLines by checking any element.  
b. Write permissions are granted per element. Checking a write permission will also grant 

read permission to all areas in MultiLines. 
c. Package permissions are in the MultiLines section. Checking a write permission will grant 

package permissions as well as grant read permission to all areas in MultiLines. 
 

3. RateManager Testing: Allows users to work in the Testing Module. Users are granted full access 
when the element is checked. 

 
4. RateManager Package Admin: Allows users to work with packages in the system and allows 

user to input mappings. Users are granted full access when the element is checked. 
a. Program Export: Allows users to create export programs on the Library tab. The 

permission may be needed by users who work with templates. 
b. Program Import: Allows users to apply exported programs and templates on the Library 

tab. The permission is needed by users who work with templates. 
c. Release Management: Allows users to work in the Releases Module. Users are granted 

full access when the element is checked. 
 

5. Database Support: Allows users to work on Database Backups and Database Restores. Users 
are granted full access when the element is checked. 

 
6. LOB: Each line of business will have rights separate from the other lines. 

a. Read permissions are granted to all areas within the line by checking any element.  
b. Write permissions are granted per element. Checking a write permission will also grant 

read permission to all areas in the line. 
c. Package permissions are in the Program Management section. Checking a write 

permission grants package permissions as well as grant read permission to all areas in 
the line. Package permissions also allows for users to manage folders, move, copy, and 
create revisions. 
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User Actions Definitions 
 
Write Access will allow users to create and edit entries. Users who do not have write access will have 
Read-Only access unless access to the entire module has not been granted. 
 

• View: Allows users to view the elements that have been created. 
 

• Write: Allows users to create, edit, copy, and delete elements. 
 

• Package: Allows users to create RateManager, SoftRater and Global Versioning packages.  
 

• Lock: Allows users to lock programs. 
 
 
Assigning Group Rights 
 
Edit group's rights when you want to change the applications and lines of business users of that group 
have access to.  
 

1. Navigate to the Edit Management tab and select the group whose rights you want to edit. Click 
Rights. If an email address has been entered for the group, the group's name is hyperlinked and 
underlined (such as Admin). For these groups, click to the right of the name to select. 

 
2. This opens the Rights Management window. 

 

 
Figure 35 Expanded Group Rights Management Screen 



Chapter 5 – Security 

53 

3. From here, you can assign rights to the group for the various modules of RateManager. Expand 
the appropriate section and place a check next to an item to give the group access to that 
section.  
 
For example, if you wanted to allow this group to access and change sections of the Auto line of 
business, you would expand RateManager Auto by clicking the  (plus box). You would then 
expand each section of Auto (Variables, Algorithms, etc.) and place a check in the Write Access 
box for each section where you wanted users to have access. If you only wanted to allow a group 
to view a section, but not make any changes, you would only place a check next to that item and 
not the Write Access box. 
 

4. When you are finished making changes, click Save. To cancel your changes, click Close.  
 
 
No Permissions to Work in Lines 
 
After a group has been added, you must assign group permissions. If you do not, users will not have 
access to lines. 
 
If a user does not have access to lines of business, they are not assigned to a group that has the proper 
permissions. Have the user close out of their session prior to changing their group or group permissions. 
 

 
Figure 36 Users Denied Access to Lines 

EDITING A GROUP 
 
Edit a group when you want to change the group's name, description, location or email address. Any 
changes will apply to all members of the group. 
 
 
To Edit a Group 
 

1. Navigate to the Group Management tab. 
 
2. Select the group you would like to edit and click Edit. You also can edit a group by double-

clicking it. If an email address has been entered for the group, the group's name will be 
underlined (such as Administrator). For these groups, click to the right of the group name to 
select it or click the underlined name to send the group an email. 

 
3. This will open the Edit Group tab. 
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Figure 37 Editing a Group 
 

4. All fields can be edited. Make your changes. 
 
5. When you have finished making changes, click Save to update the group's information and 

refresh the group listing. If you do not want to save your changes, click Cancel. 
 

DELETING A GROUP 
 
If a group is no longer needed, it can be deleted. Only groups that currently have no users assigned to 
them can be deleted. 
 
 
To Delete a Group 
 

1. Navigate to the Group Management tab. 
 
2. Select the group you want to delete and click Delete. 

 
3. If the group currently has users assigned to it, you will receive an error.  
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Figure 38 Error Message for Deleting a Group 

 
4. Remove all users from the group by either deleting the users or assigning the users to another 

group (see Editing a User) and then try your delete request again. 
 

 
Figure 39 Deleting Group Confirmation Message 

 
5. If the group does not have any users assigned to it, you will be asked to confirm deletion of the 

group. 
 
6. Click OK to delete the group and refresh the group listing. Click Cancel to return to the group 

listing without deleting the group. 
 
 
Group Management Tab 
 
A completed Group Management tab lists the groups, the location of the group and the total number of 
members in each group.  
 
The number of users may be greater than the total number of users. Users may be assigned to more than 
one group. 
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Figure 40 Completed Group Management Tab 
 
 
Viewing Group Contact Information 
 
If you have entered any contact information for the group, you can view that information by holding your 
cursor over the group name. 
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SESSION MANAGEMENT 
 
The Session Management tab allows an administrator to view users who currently have a RateManager 
session open and disconnect them to free up a locked element. 
 

 
Figure 41 Session Management 
 
From this tab you can: 
 

● Deactivate a License 
● Display the users who have an Element or Program Lock 

 

FUNCTIONALITY 
 
The Menu Bar is located at the top of the tab. The menu bar contains the functions you can perform on 
this tab. 
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Functions: 
 

 
Deactivate License:  Deactivates the license of the selected user. This will 
immediately end their session.  

 
Edit: Unlocks a locked element by forcing an edit tab to close. Any changes made 
on a forced close tab will not be saved. 

 Refresh:  Refreshes the list of open sessions. 

FIELDS 
 
The main body of the tab displays the sessions that are currently open. There are four fields in the main 
body of the Session Management tab.  
 

Checkbox: Check this box to perform an action on this session. 
 
User: The name of the user who has a session open.  
 
Issue Date: The time stamp that the session began. 
 
Comments: The IP or URL of the open session. 
 

: Indicates that this user has an element open. Open elements are locked to prevent users from 
overwriting each other’s work. If a user has had an element locked for an extended period of time, 
the session can be ended. This frees the element to be worked on by other users. 

 
 
To Navigate to Session Management 
 

1. Select ToolsSecuritySession Management. 
 

2. This will open the Session Management tab. 
 

DEACTIVATING A SESSION 
 
If a user quits RateManager without first logging out, their session may remain open. In this event, you 
need to deactivate the session. Deactivating a session will also release any locked elements that this 
user may have outstanding. 
 
 
To Deactivate a Session 
 

1. Navigate to the Session Management tab. 
 

2. Place a checkmark next to each session you want to deactivate (free up) and then click 
Deactivate License.  
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3. You will be asked to confirm the deactivation. 
 

 
Figure 42 Confirming a Deactivation 

 
4. Click OK to deactivate the session or Cancel to return to the Session Management tab. 

 

UNLOCKING ELEMENT LOCKS 
 
If you want information about a session lock, you can view information about who has an element locked 
by holding your cursor over the In-Use icon found on the Program Details tab.  
 

 
Figure 43 User Session with Extended Locked Element 
 
If you want the element to be released, the system administrator can end the session of the user who is 
locking the element. This frees the element up, allowing other users to access the element. 
 
NOTE: Prior to ending a user session, verify that the element has been locked for an extended period of 

time. Ending a user session prior to the element being saved may result in the user’s updates not 
being implemented. 
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Deactivating a User Session 
 
The License Lock option displays the details of the element lock in Session Management.  
 
 

 
Figure 44 Ending a User Session with a Locked Element 
 

1. To view how long this user has had a lock on the element, place a check mark in the box next the 
user. 
 

2. Click License Locks. A popup window is displayed indicating which element the user has locked 
and for how long. 
 

 
Figure 45 Locked Items by User 
 

3. The Locked Items by User box is for information only. No action can be performed here. If you 
need free this element and end this user’s session, you can deactivate the session. 
 

4. Close out the Locked Items by User popup. 
 
5. To deactivate the session, place a check mark in the box next to the user. 
 
6. Click deactivate license. 
 
7. Click OK to confirm the disconnect, click Cancel if you do not want to disconnect the user 

session. 
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Chapter 6 

DATABASE 
 
The Database Module can be found on the Tools menu. The Database module is where you manage 
database functions from within RateManager. There are two options you can select: 
 

● Backups – used for creating and restoring database backups. 
 

● Updates – a listing of available updates for this version of RateManager. 
 

BACKUPS 
 
The backup tab located in the Database option of RateManager allows an administrator to create and 
restore backups of the RateManager database. You must be a Disk Admin to perform backups or 
restores. 
 

 
Figure 46 Database Backups 
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FUNCTIONALITY 
 
The Menu Bar is located at the top of the tab. The menu bar contains the functions you can perform on 
this tab. 
 
 
Functions: 
 

 Create Backup: Creates a backup of the currently selected database. 

 Restore Backup: Restores the currently selected database. 

 Delete Backup: Deletes the currently selected database. 

 Refresh:  Refreshes the list of backups. 
 

FIELDS 
 
The main body of the tab displays a list of the current backups. There are six fields in the main body of 
the DB Backups tab. 
 

Checkbox: Check this box to perform an action on this backup. 
 
Type: The type of backup performed, either Maintenance or Error. 
 
Name: The name of the database being backed up. 
 
Location: The location of the backup. 
 
Date: The time stamp of the backup. 
 
Size: The size of the backup. 

 
 
Navigating to Database  
 

1. Select ToolsDatabaseBackups. 
 
2. This will open the Backups tab. 

 

CREATING A BACKUP 
 
If you need assistance implementing logic or an error is found in the system, a backup or snapshot can 
be made of the database. That snapshot can then be sent to Oracle Insurance Support, where it will be 
restored. Our support personnel and analysts can then work from the snapshot to determine the best way 
to implement logic or diagnose a problem. 
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To Create a Database Snapshot 
 

1. Navigate to the Backups tab. 
 

2. Click CREATE BACKUP. This will open the RateManager Backup window. 
 

 
Figure 47 Creating a Backup 

 
3. Select the database you want to backup, either security or rm (RateManager). When creating a 

backup to send to Oracle Insurance, select your rm database. The Name on the screen will 
default to the actual name of the database in SQL Server. 
 

4. Select a reason for the backup, either Maint (maintenance) or Error. 
 

5. Enter a location where the backup should be stored. This location should be a network share. 
 

6. Click BACKUP to start the backup process. 
 

7. You will be informed when the backup operation is complete.  
 

 
Figure 48 Successful Backup Message 
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8. Your backup should be listed on the backups tab. If your backup is not listed, click REFRESH to 
refresh the screen.  
 
 

Sending to Oracle Insurance 
 
If necessary, you may need to send it to Oracle Insurance Support for assistance. 

 
1. Once the backup is complete, you can browse to the backup location you entered in Step 5. Sort 

the listing by Date Modified to quickly find the backup you just created.  
 

2. If necessary, Oracle Insurance Support will instruct you how to handle the database handoff. 
 

RESTORING A BACKUP 
 

1. If there’s a backup that needs to be restored, highlight the backup you want to restore and click 
RESTORE BACKUP. A warning message will be displayed.  

 
NOTE:  If you require assistance or are unsure of whether or not to restore a backup, please log a 

Service Request using My Oracle Support at https://support.oracle.com/. 
 

 
Figure 49 Restore Warning Message 

 
2. Click RESTORE to restore the backup or CLOSE to return to the previous screen. 

 

https://support.oracle.com/
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DELETING A BACKUP 
 
If there’s a backup that you no longer need, you can delete it. Make sure this is the action you want to 
take. 
 

1. Highlight the backup(s) you want to remove. More than one backup can be deleted. 
 

2. Click Delete Backup(s) from the top bar menu. A warning message will be displayed.  
 

3. Click OK to remove the backup(s) or Cancel to return to the previous screen. 
 

 
Figure 50 Deleting a Backup 
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Permissions Error 
 
If you do not have the proper permissions to run database backups or restores, you will receive an error 
message.  
 

 
Figure 51 Permissions Error Message 
 
 
Database Backup Location Error 
 
If you do not have a proper backup location set up, either on the server where your databases are located 
or a network share, you will receive an error message.  
 

 
Figure 52 Backup Location Error Message 
 
In Figure 52, a backup location was entered (C:\Insbridge\DB_Backup…), but the location was not found. 
Entering a location in the Preferences area of RateManager will not create the location. The location must 
be in place prior to the backup.  
 
When a shared location on the server where the RateManager databases are located is entered, the 
backup request can be performed. 
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UPDATES 
 
The database module also contains an update tab that lists the available updates for this version of 
RateManager. 
 
From this tab you can view the update script or execute the update. Updates cannot be deleted. 
 
NOTE:  Only a database owner (db_owner) can perform updates. If the Updates tab or any execute 

buttons are not visible, you do not have access to the database. 
 

 
Figure 53 DB Updates 

FUNCTIONALITY 
 
The Menu Bar is located at the top of the tab. The menu bar contains the functions you can perform on 
this tab. 
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Functions: 
 

 Execute Update Script: Runs the selected update script. 

 
Open Update Script: Opens the selected update script in a 
window where it can be viewed or copied. 

 
Save Update Script to File: Allows you to save the update script 
to your local hard drive or network. 

 Refresh: Refreshes the list of updates scripts. 

 
Show Updates for: Allows you to select the update scripts you 
want to view, IBRM or IB_CLIENT. 

 

FIELDS 
 
The main body of the tab displays a list of database updates. There are four fields in the main body of the 
DB Updates tab. 
 

Script: The name and version of the script. 
 
Release Date: The date of the release for the script.  
 
Database: The type of database the script is for, IB_CLIENT or IBRM. 
 
Status: The status of the update. Current will be on the line of the most current database. 

 
 
Navigating to Database  
 

1. Select ToolsDatabaseUpdates. 
 
2. This will open the Updates tab. 

 

EXECUTING UPDATE SCRIPT 
 
Database updates can be done on the IB_CLIENT database and the IBRM database. If you log into 
RateManager and Tools is the only option, you must perform a database update. 
 
On the Updates tab, the current version will be highlighted and the status will be Current. The updates 
below the current version will be grayed out. These updates cannot be run again. You will receive an 
error message if you attempt to run a lower version update. Any version update above the current version 
will also be grayed out but will be available for executing after the preceding update has been run. 
 
Updates have to be installed sequentially, meaning if you are on Version 3.12, you must run the 3.13 
update, the 4.00 update, the 4.01 update and finally the 4.06 update. If you attempt to run an update that 
is more than one level above the current version, you will receive an error message. 
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NOTE:  It is strongly recommended that database updates be performed in RateManager. 
 
 

1. Navigate to ToolsDatabaseUpdates. 
 

2. The Updates tab is displayed. Select the database you want to view from the Show updates for 
drop down. The database updates for your selection will be listed. The last column, the Status 
column, will show you which update is the Current one installed. 

 

 
Figure 54 Available Updates 
 

3. There are two ways to execute an update: 
  

a. Directly in RateManager 
b. In SQL Server 

 
 
Directly in RateManager 
 
This is recommended way to update a database. It is recommended that you start by selecting the update 
showing Current. This will assure that the database showing as Current will have all possible updates. 
 

4. Highlight the update you want to run.  
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5. Click Execute Update Script. A warning message will be displayed.  
 
6. Click OK to run the update or Cancel to return to the previous screen.  

 
7. Do this for both the IBRM database and the IB_CLIENT database. 

 

 
Figure 55 Updating Scripts in RateManager 

 
 
In SQL Server Using Query Analyzer 
 
This method should be performed by a database administrator. You must have access to the SQL 
Server instance where the RateManager databases are located. No warning message will be 
displayed if you execute scripts in the wrong order. You must know the name of the databases you 
are updating. If you are unsure, do not use this method.  
 
WARNING: Running updates in a non-sequential order may result in severe database errors. No error 

messages will be displayed if you run updates in an incorrect order. 
 

1. In RateManager, highlight the update you want to run. If you are going from a much lower version 
of RateManager, you may have to save multiple files for each database.  
 

2. Click Save To File. Your computers dialogue box will be displayed. Save the file to a location of 
your choice. For IBRM scripts, it is recommended that you rename the file to 
usp_IBRM_R0(version number).sql. For example the V4.06.01 update would be: 
usp_IBRM_R40.06.01.00.sql. For IB_CLIENT scripts, it is recommended that you rename the file 
to usp_IB_CLIENT_R0(version number).sql. For example the V4.06.01 update would be: 
usp_IB_CLIENT_R04.06.01.00sql.  

 
3. Open Query Analyzer in SQL Server. 

 
4. Open up the DB script updates from the download file. You can open in any program you want, 

such as Notepad.  
 
5. Select the IB_CLIENT database. Create a new query. 
 
6. Copy the DB script you opened to the query screen.  
 
7. Execute the script. Any messages will be displayed in the lower portion of the screen. Fix any 

errors before you continue. 
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8. Updates must be run in sequential order. 
 
9. Do the same for the RM database. 
 
10. After the scripts have been run, return to RateManager. Click FileReload. The status should 

show current and the full RateManager menu should be displayed. 
 
Open Update Script 
 
To view the update script prior to execution, highlight the update you want to view. Click Open Update 
Script. The update script will be displayed in a separate screen. 
 

 
Figure 56 Script Viewer 
 

REQUIRED UPDATES 
 
If you log into RateManager and Tools is the only option, you must perform a database update. 
 
Please navigate to ToolsDatabaseUpdates (Tab) and run the necessary updates. You will not be 
able to continue until you run the updates. 
 

 
Figure 57 Menu Requiring DB Updates 
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Figure 58 Please Run Update Scripts 
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CHANGING YOUR PASSWORD 
 
You can change your password at any time. RateManager does not prompt users to change their 
passwords.  
 
It is recommended that you change your password periodically to prevent other users from logging in and 
making changes using your user ID. 
 

1. From the top bar menu, select Tools and then click Change Password. 
 

 
 

2. This will open the Change Password window. 
 

 
Figure 59 Change Password Screen 

 
3. Enter your current password in the Old Password text box and enter your new password in the 

New Password and Confirm Password text boxes.  
 
Your password must be at least six, but fewer than twelve, alphanumeric characters. 
 

4. When you are finished, click Update to update your password. The next time you log into 
RateManager, you will need to use your new password. 
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PREFERENCES 
 
Users with Administration rights will be able to access all options found on the Preferences screen. The 
Preferences screen allows administrators to manage settings, and set Home Page options.  
 
Non-administrators will only have the option to set their Home Page Snaps. Please see the RateManager 
User Guide. 
 

ADMIN SETTINGS 
 
Administrators can edit web settings at any time from the Preferences screen. Changes will take place 
after the user sessions have been ended. 
 
From the Preferences screen, you can set pathways, define servers, backup shares, set preferences, set 
batch threads, establish minimum ID lengths, display of override date-mask values for Importing Data for 
Mapped Variables, allow users to edit data types within the application, and set the time for inactive 
session timeout. 
 
 
To Change Settings 
 

1. Select ToolsPreferences. 
 

2. This will open the Preferences window. Select Web Settings. This option is displayed if you are 
an administrator. 
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Figure 60 Preferences Settings 
 

3. Make any necessary changes. 
 

4. When you are finished, click Save to update your settings. If you want to changes to take place 
immediately, you may have to end all user sessions.  

 

Web Settings 
 
Insbridge ConfigXml Path 
 
This is the path from IBFA. This pathway must match the IBFA path. You may need to change this path if 
you have changed the path in IBFA. Please contact Insbridge support for further information.  
 
It is strongly recommended that you leave the default.  
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Messaging Server 
 
RateManager is set up to run batches on the same server that RateManager is located on. If you have an 
especially large batch to run and you want to batch to a different server, you will have to change server 
locations here. Unless necessary, it is strongly recommended that you leave the default. 
 
 
SoftRater Server 
 
If you need to rate on another server, you will have to change server locations here. It is strongly 
recommended that you leave the default. 
 
 
Work Files Share Folder Location 
 
A shared Workfiles location allows for multiple instances of RateManager to share the same Workfiles. 
The IBRU server and the shared location must be on the same domain. The Insbridge user must be on 
the domain also. 
 
For instructions on setting up a WorkFiles Share Location, please see the Insbridge WorkFiles Installation 
Guide on the http://www.oracle.com/technetwork/documentation/insurance-097481.html 
 
 
DB Backup Share Folder Location 
 
When you make backups of the RateManager database, you can specify the location of the backup file. If 
the location is local, you will use a local path. If the location is not local, you must be a disk admin to 
change. 
 
If the database is on a remote server, a share is needed for the backup location. The Insbridge user must 
have write access to this location as well. 
 
 
Use Insbridge Com + Admin 
 
This setting must always be true. If there is a conflict, please contact Oracle Insurance support. 
 
 
Enforce Release Packaging 
 
When set to False, a release is not required in order for users to create a SoftRater (full) package. False 
is the default setting. 
 
If set to True, a release is required in order for a SoftRater (full) package to be created. If a user wants to 
create a SoftRater (full) package in the Program Explorer module, a release must be created in the 
Releases area first. This release must have the program added to it and be unlocked. When the user 
creates the SoftRater package in Program Explorer, they will have the option to select the Release they 
want this package to be placed into. If there is no release, or no release that contains that program and is 
unlocked, then the user will be able to do RateManager (local) packages only. 
 
 
  

http://www.oracle.com/technetwork/documentation/insurance-097481.html
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Batch Package Threads 
 
RateManager allows you to change how many threads are used. Threading enables a process to finish 
faster by splitting the process into smaller processes that run quasi-simultaneously. On multiprocessor 
systems, using multiple threads enables the operating system to assign the threads to different 
processors. 
 
In addition, the Framework Administrator also enables you to change the administrator email address for 
each client. When a process fails, an email will be sent to the person who initiated the process, as well as 
to the administrator email addresses listed for the client of that process. 
 
 
NOTE:  Before changing the number of threads, you should consult with your system 

administrator. Setting the number too high can result in poor performance or even a 
system crash. If you are unsure of how many threads to use, set the number to 1. For 
single processor systems, Oracle Insurance recommends a maximum of 2 threads. 

 
 
Minimum Login User ID Length 
 
This is the minimum number of characters required for a user ID. 
 
 
User must change password 
 
This where you set the number of days before a user is required to change his/her password. This setting 
will only be active when you elect to have users change their password on the user setup screen.  
 
 
Show Override Date Mask 
 
If enabled, a date mask for ‘Date’ data types will be displayed when importing a table. If not enabled, this 
field will not be visible. 
 
 
Allow Data Type Change 
 
The type of data associated with a parameter. RateManager supports three (decimal, integer and string) 
data types for variables and inputs and a fourth (date) for inputs and result variables only. 
 
Setting this option to True will allow RateManager users change the data type of a variable or input. 
Setting this option to False will not allow users to change data types. 
 
 
Inactive Session Time Out  
 
This is the amount of time that a user sits inactive before being automatically logged out of the system.  
 
 
Batch Results with New Line  
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Allows batch results to go to a new line instead of forming one continuous string. A True setting will place 
a carriage return between result files. A False setting will result in one continuous string without a break. 
 
 
Online Help Server  
 
Online help is installed with RateManager. This setting is the default server name where RateManager 
currently resides. Either a server name or an IP address can be entered here. If needed, you can change 
the name of the server. For example, if the machine name is not the same as the host name, you may 
need to change the name in order for online help to function. 
 
 
My Recent List 
 
My Recent List is a snap setting. Snaps are modules that contain information or links to elements that the 
user recently worked on. You can set the maximum number of elements to display in a snap. The default 
is for the snap list to be limited to 10. 
 
 
Default Proxy Script Location 
 
The Default Proxy Script Location setting may be needed if you elect to use the Oracle Insurance Blog 
Feed snap. This setting can be used for RSS feeds. 
 
 
Change Control 
 
If change control is on, it will be mandatory for users to enter a change control entry and justification to 
any element or program when it is revisioned. If change control is off, the option will not be presented. 
 
 
Maximum Amount of Simultaneously Opened Tabs 
 
Use the maximum amount of simultaneously opened tabs setting to set the maximum number of tabs you 
will allow users to have opened in RateManager. The default is 15. 
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Chapter 9 
 

VIEWING VERSIONS 
 
The Version option in the Tools section of RateManager allows an administrator to view the version 
information for the current system. 
 
 
To View a Version 
 

1. From the Home tab, select HelpRateManager Version. 
 

 
 
2. This will open the Version Listing window. 
 

 
Figure 61 Version Listing 

 
3. The latest version information including RateManager release number, IB Client schemas and 

build will be displayed. 
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Support 

CONTACTING SUPPORT 
 
 
If you need assistance with an Oracle Insurance Insbridge Rating and Underwriting System product, 
please log a Service Request using My Oracle Support at https://support.oracle.com/. 
 
 
Address any additional inquiries to: 
 
Oracle Corporation 
World Headquarters 
500 Oracle Parkway 
Redwood Shores, CA 94065 
U.S.A. 
 
Worldwide Inquiries: 
Phone: +1.650.506.7000 
Fax: +1.650.506.7200 
oracle.com 
 
 

TTY Access to Oracle Support Services 
 
Oracle provides dedicated Text Telephone (TTY) access to Oracle Support Services within the United 
States of America 24 hours a day, seven days a week. For TTY support, call 800.446.2398. 
 

Deaf/Hard of Hearing Access to Oracle Support Services 
 
To reach Oracle Support Services, use a telecommunications relay service (TRS) to call Oracle Support 
at 1.800.223.1711. An Oracle Support Services engineer will handle technical issues and provide 
customer support according to the Oracle service request process. Information about TRS is available at 
http://www.fcc.gov/cgb/consumerfacts/trs.html, and a list of phone numbers is available at 
http://www.fcc.gov/cgb/dro/trsphonebk.html. 
 
 

https://support.oracle.com/
http://www.fcc.gov/cgb/consumerfacts/trs.html
http://www.fcc.gov/cgb/dro/trsphonebk.html
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Appendix 

COUNTRY CODES 
 
 
NAME ABBR 
AFGHANISTAN AFG 
ALBANIA ALB 
ALGERIA DZA 
AMERICAN SAMOA ASM 
ANDORRA AND 
ANGOLA AGO 
ANGUILLA AIA 
ANTARCTICA ATA 
ANTIGUA AND BARBUDA ATG 
ARGENTINA ARG 
ARMENIA ARM 
ARUBA ABW 
AUSTRALIA AUS 
AUSTRIA AUT 
AZERBAIJAN AZE 
BAHAMAS BHS 
BAHRAIN BHR 
BANGLADESH BGD 
BARBADOS BRB 
BELARUS BLR 
BELGIUM BEL 
BELIZE BLZ 
BENIN BEN 
BERMUDA BMU 
BHUTAN BTN 
BOLIVIA BOL 
BOSNIA AND HERZEGOWINA BIH 
BOTSWANA BWA 
BOUVET ISLAND BVT 
BRAZIL BRA 
BRITISH INDIAN OCEAN TERRITORY IOT 
BRUNEI DARUSSALAM BRN 
BULGARIA BGR 
BURKINA FASO BFA 
BURUNDI BDI 
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NAME ABBR 
CAMBODIA KHM 
CAMEROON CMR 
CANADA CAN 
CAPE VERDE CPV 
CAYMAN ISLANDS CYM 
CENTRAL AFRICAN REPUBLIC CAF 
CHAD TCD 
CHILE CHL 
CHINA CHN 
CHRISTMAS ISLAND CXR 
COCOS (KEELING) ISLANDS CCK 
COLOMBIA COL 
COMOROS COM 
CONGO COG 
COOK ISLANDS COK 
COSTA RICA CRI 
COTE D'IVOIRE CIV 
CROATIA (local name: Hrvatska) HRV 
CUBA CUB 
CYPRUS CYP 
CZECH REPUBLIC CZE 
DENMARK DNK 
DJIBOUTI DJI 
DOMINICA DMA 
DOMINICAN REPUBLIC DOM 
EAST TIMOR TMP 
ECUADOR ECU 
EGYPT EGY 
EL SALVADOR SLV 
EQUATORIAL GUINEA GNQ 
ERITREA ERI 
ESTONIA EST 
ETHIOPIA ETH 
FALKLAND ISLANDS (MALVINAS) FLK 
FAROE ISLANDS FRO 
FIJI FJI 
FINLAND FIN 
FRANCE FRA 
FRANCE, METROPOLITAN FXX 
FRENCH GUIANA GUF 
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NAME ABBR 
FRENCH POLYNESIA PYF 
FRENCH SOUTHERN TERRITORIES ATF 
GABON GAB 
GAMBIA GMB 
GEORGIA GEO 
GERMANY DEU 
GHANA GHA 
GIBRALTAR GIB 
GREECE GRC 
GREENLAND GRL 
GRENADA GRD 
GUADELOUPE GLP 
GUAM GUM 
GUATEMALA GTM 
GUINEA GIN 
GUINEA-BISSAU GNB 
GUYANA GUY 
HAITI HTI 
HEARD AND MC DONALD ISLANDS HMD 
HONDURAS HND 
HONG KONG HKG 
HUNGARY HUN 
ICELAND ISL 
INDIA IND 
INDONESIA IDN 
IRAN (ISLAMIC REPUBLIC OF) IRN 
IRAQ IRQ 
IRELAND IRL 
ISRAEL ISR 
ITALY ITA 
JAMAICA JAM 
JAPAN JPN 
JORDAN JOR 
KAZAKHSTAN KAZ 
KENYA KEN 
KIRIBATI KIR 
KOREA, DEMOCRATIC PEOPLE'S REPUBLIC OF PRK 
KOREA, REPUBLIC OF KOR 
KUWAIT KWT 
KYRGYZSTAN KGZ 
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NAME ABBR 
LAO PEOPLE'S DEMOCRATIC REPUBLIC LAO 
LATVIA LVA 
LEBANON LBN 
LESOTHO LSO 
LIBERIA LBR 
LIBYAN ARAB JAMAHIRIYA LBY 
LIECHTENSTEIN LIE 
LITHUANIA LTU 
LUXEMBOURG LUX 
MACAU MAC 
MACEDONIA, THE FORMER YUGOSLAV REPUBLIC OF MKD 
MADAGASCAR MDG 
MALAWI MWI 
MALAYSIA MYS 
MALDIVES MDV 
MALI MLI 
MALTA MLT 
MARSHALL ISLANDS MHL 
MARTINIQUE MTQ 
MAURITANIA MRT 
MAURITIUS MUS 
MAYOTTE MYT 
MEXICO MEX 
MICRONESIA, FEDERATED STATES OF FSM 
MOLDOVA, REPUBLIC OF MDA 
MONACO MCO 
MONGOLIA MNG 
MONTSERRAT MSR 
MOROCCO MAR 
MOZAMBIQUE MOZ 
MYANMAR MMR 
NAMIBIA NAM 
NAURU NRU 
NEPAL NPL 
NETHERLANDS NLD 
NETHERLANDS ANTILLES ANT 
NEW CALEDONIA NCL 
NEW ZEALAND NZL 
NICARAGUA NIC 
NIGER NER 
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NAME ABBR 
NIGERIA NGA 
NIUE NIU 
NORFOLK ISLAND NFK 
NORTHERN MARIANA ISLANDS MNP 
NORWAY NOR 
OMAN OMN 
PAKISTAN PAK 
PALAU PLW 
PANAMA PAN 
PAPUA NEW GUINEA PNG 
PARAGUAY PRY 
PERU PER 
PHILIPPINES PHL 
PITCAIRN PCN 
POLAND POL 
PORTUGAL PRT 
PUERTO RICO PRI 
QATAR QAT 
REUNION REU 
ROMANIA ROM 
RUSSIAN FEDERATION RUS 
RWANDA RWA 
SAINT KITTS AND NEVIS KNA 
SAINT LUCIA LCA 
SAINT VINCENT AND THE GRENADINES VCT 
SAMOA WSM 
SAN MARINO SMR 
SAO TOME AND PRINCIPE STP 
SAUDI ARABIA SAU 
SENEGAL SEN 
SEYCHELLES SYC 
SIERRA LEONE SLE 
SINGAPORE SGP 
SLOVAKIA (Slovak Republic) SVK 
SLOVENIA SVN 
SOLOMON ISLANDS SLB 
SOMALIA SOM 
SOUTH AFRICA ZAF 
SOUTH GEORGIA AND THE SOUTH SANDWICH 
ISLANDS SGS 
SPAIN ESP 
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NAME ABBR 
SRI LANKA LKA 
ST. HELENA SHN 
ST. PIERRE AND MIQUELON SPM 
SUDAN SDN 
SURINAME SUR 
SVALBARD AND JAN MAYEN ISLANDS SJM 
SWAZILAND SWZ 
SWEDEN SWE 
SWITZERLAND CHE 
SYRIAN ARAB REPUBLIC SYR 
TAIWAN, PROVINCE OF CHINA TWN 
TAJIKISTAN TJK 
TANZANIA, UNITED REPUBLIC OF TZA 
THAILAND THA 
TOGO TGO 
TOKELAU TKL 
TONGA TON 
TRINIDAD AND TOBAGO TTO 
TUNISIA TUN 
TURKEY TUR 
TURKMENISTAN TKM 
TURKS AND CAICOS ISLANDS TCA 
TUVALU TUV 
UGANDA UGA 
UKRAINE UKR 
UNITED ARAB EMIRATES ARE 
UNITED KINGDOM GBR 
UNITED STATES USA 
UNITED STATES MINOR OUTLYING ISLANDS UMI 
URUGUAY URY 
UZBEKISTAN UZB 
VANUATU VUT 
VATICAN CITY STATE (HOLY SEE) VAT 
VENEZUELA VEN 
VIET NAM VNM 
VIRGIN ISLANDS (BRITISH) VGB 
VIRGIN ISLANDS (U.S.) VIR 
WALLIS AND FUTUNA ISLANDS WLF 
WESTERN SAHARA ESH 
YEMEN YEM 
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NAME ABBR 
YUGOSLAVIA YUG 
ZAIRE ZAR 
ZAMBIA ZMB 
ZIMBABWE ZWE 
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Glossary 

GLOSSARY TERMS 
 

A 
Administrator: The person designated by your company who has the authority to 

create and change groups, usernames, passwords and restrictions. 
Algorithm: A sequence of steps used to perform a calculation.  
Assigned Driver: A driver who has been assigned to a vehicle. 
Assigned Vehicle: A vehicle that has been assigned a driver. 
Authoring 
Environment 

The physical machine where RateManager is installed.  

C 
Calculated Variable: Calculated Variables are used when a result cannot best be derived 

from simple data mapping in a table. For example, if age is not passed 
as an input, but is a criteria needed in determining other factors, you 
would use a Calculated Variable to calculate driver age from the inputs 
of effective date and driver date of birth. Calculated Variables look at 
every node (driver, vehicle, location, etc.) independently and create a 
result for each. Once a calculated variable is created, the result can be 
used in any other variable. 

Callouts A set of a single or multiple programs and/or SoftLibraries that allows 
users to call needed operations at a specific time from either inside the 
system or outside the system. 

Category: A user defined group of information that defines inputs, variables, 
algorithms and the overall structure of the program. 

Criteria: An input or variable used in a mapped variable to determine which 
value to return. Any input or variable can be used as a criteria. 

D 
Data Type: The type of data associated with a parameter. RateManager supports 

three (decimal, integer and string) data types for variables and inputs 
and a fourth (date) for inputs and result variables only. 

Date: A data type supported for inputs and result variables only. For more 
information, see Dates in the Contents section. 

Decimal: A data type supported for all types of variables and inputs. Examples 
of decimal values are 3.1415, 18 and 0.995. 

Default Value: Used by a mapped variable if no match is found based on the criteria. 
Dependency: When copying a variable, algorithm or driver assignment, any element 

that requires another element to be present or defined will be listed. All 
dependencies must be resolved. 

Driver Assignment: Driver assignment is an auto insurance specific method of assigning a 
particular driver to a particular vehicle on a policy, based on certain 
criteria. Criteria often differ on a carrier basis, and sometimes even on 
a program level. 

Driver Assignment A driver assignment scenario is a list of instructions that define the 
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Scenario: main sequence of operations to properly define the driver assignment 
logic for a carrier. A scenario is based upon the same algorithm 
principle used throughout the RateManager software. 

E 
Export: Exports allow users to export all elements of a program from one 

database to another database or within the same database. Or to 
export data in tab-delimited form, from a RateManager table to an 
outside location. 

F 
Flag: A variable that holds a 1 for true and a 0 for false. 
Flag Driver Algorithm: An algorithm used by a Flag Driver Function to flag drivers based on 

certain criteria. 
Flag Driver Function: A built-in function used in the main driver assignment that defines the 

scope of the flagging operation. Most require an association with a 
predefined Flag Driver Algorithm. 

Flag Vehicle 
Algorithm: 

An algorithm used by a Flag Vehicle Function to flag vehicles based on 
certain criteria. 

Flag Vehicle Function: A built-in function used in the main driver assignment that defines the 
scope of the flagging operation. Most require an association with a 
predefined Flag Vehicle Algorithm. 

G 
Global: An input or variable that is available to all programs under a specific 

subline. 
Global Input: A value that is passed into the rating system. 
Global Result: A value that is passed out of the system after rating.  
Group: A set of users that have the same access rights. 

I 
IBFA Insbridge Framework Administrator. IBFA is an administrative tool 

used to configure Insbridge applications and setup RateManager 
database connections. IBFA will be located on a Windows Server 
machine. IBFA/SR-WIN is an Insbridge Framework 
Administrator/SoftRater for Windows.  

IBSS Insbridge SoftRater Server. IBSS is the administrative tool for the 
SoftRater engine. The SoftRater engine is a multi-platform component 
within IBRU that executes the rules, rating and underwriting 
instructions as defined by the user in RateManager. IBSS is usually 
located on a Java machine. IBSS/SR-JAVA is an Insbridge SoftRater 
Server/SoftRater for Java.  

IBRU Insbridge Rating and Underwriting System. This is the entire system.  
If: A step type available for use in calculated variables and algorithms. 

For more information, see If in the contents section. 
Import: Import allows users to bring in programs from an outside location into 

RateManager. Or to import data in tab-delimited form, into a 
RateManager table. 

Input: A value that is passed into the rating system. 
Integer: A data type supported for all types of variables and inputs. Examples 

of integer values are 3, 1859865 and -47. 
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Interpolation: An estimated value derived from two known values. 

L 
Library: The Library is where templates are stored and managed. 
Linked Variables: Two or more mapped variables that have been associated with one 

another because they use the same criteria. 
Lock: A lock will close all associated Variables, Algorithms, Driver 

Assignments, Sequencing and Result Mappings in a program version 
from deletions and edits. 

Logical Environment An environment created for a subscriber in IBFA. It defines package 
location, engine location and database location in addition to several 
other supporting data items. This environment is used for rating and/or 
SRP management. Each database connection will have a logical 
environment.  

M 
Mapped Variable: A variable that uses other variables and inputs as criteria in 

determining the appropriate value. See Mapped Variables in the 
Contents section for more information. 

Mask: A feature that allows the customer to determine how data should be 
interpreted. See Masking in the Contents section for more information. 

N 
Normal Rating 
Algorithm: 

The most common type of algorithm. Examples of what it can be used 
for are:  
● Determine premiums 
● Calculate differences in limits being passed into the system vs. 

limits being rated by the system 
● Assign tiers  

O 
Operator: A built-in mathematical function used in calculations and comparisons. 

P 
Package: A small file that holds all the RateManager logic for a specific program 

and version. 
Package Location A pointer to a location where SoftRater Packages (SRP's) are stored. 
Physical Environment A physical environment is generally referred to as a physical machine.  
Program: A planned group of procedures executed in a specific order to return a 

rating. Programs in RateManager typically correspond to rate manuals. 
Programs can be either created by the users or imported. 

Program Date Mask: Specifies how SoftRater interprets dates being passed into an input 
file. 

Program Folders: A RateManager file management system that functions in much the 
same way as Microsoft Windows Explorer. This multi-level setup 
allows for an unlimited number of program folders and subfolders to be 
placed underneath a subline. 

R 
Rank Driver 
Algorithm: 

An algorithm used by a Rank Driver Function to rate drivers based on 
certain criteria. 
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Rank Driver Function: A built-in function used in the main driver assignment that defines the 
scope and sorting order of the ranking operation. Most require an 
association with a predefined Rank Driver Algorithm. 

Rank Vehicle 
Algorithm: 

An algorithm used by a Rank Vehicle Function to rate vehicles based 
on certain criteria. 

Rank Vehicle 
Function: 

A built-in function used in the main driver assignment that defines the 
scope and sorting order of the ranking operation. Most require an 
association with a predefined Rate Vehicle Algorithm. 

Rating Environment The physical machine(s) where SoftRater is installed. This is typically 
the same as a SoftRater node.  

Reconcile A comparison feature that compares one program version against 
another version in the same program and generate a report of the 
differences. 

Restrictions: Limitations on viewing and editing pages and fields in the system. 
Restrictions are assigned and changed by the Administrator. 

Result Mapping: A defined set of results, inputs and variables displayed in the output 
file. 

Revision: A variable specific type of versioning. See Versioning in the Contents 
section for more information. 

RM RateManager. RateManager is a component within IBRU that enables 
users to manage the product definition and modification process, 
including rating and underwriting logic.  

S 
Sequence: The order in which algorithms run. See Sequencing in the Contents 

section for more information. 
SoftLibrary: A SoftLibrary is a specially developed program that performs a specific 

task. SoftLibraries may run their own code or call upon other systems 
to obtain information outside of RateManager, for example, obtaining a 
credit score 

SoftRater Node A SoftRater node is either an IBFA (without RateManager) or IBSS 
instance on a physical environment.  

Source: The source is the creator of a template and will also be the name of 
the new subline. 

SR SoftRater. The engine that executes the rating, rules and underwriting 
instructions defined within RateManager. The rating environment for 
runtime execution and processing of business content. SoftRater can 
be further defined by the operating system where it has been loaded.  

SRP SoftRater Packages. A package that holds all the RateManager logic 
for a specific program and version.  

SR-JAVA SoftRater for Java. This is also another name for IBSS.  
SR-WIN – SoftRater for Windows. This is also another name for IBFA.  
String: A data type supported for all types of variables and inputs. Examples 

of string values are "2.718", "The quick brown fox jumps over the lazy 
dog." and "001". 

Subline: Sublines are classifications that fall in between lines of business and 
program folders. Sublines allow for the separation of programs by 
source. 
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T 
Tab-delimited: A type of text file in which columns are separated by tabs. This is the 

required format for importing tables into RateManager. 
Template: Templates are exact copies of existing programs within a line of 

business that can be from within your own user group, any other user 
group within the company or even from an outside company.  

U 
Unassigned Driver: A driver who has not been assigned to a vehicle.  
Unassigned Vehicle: A vehicle that has not been assigned a driver. 
Underwriting 
Algorithm: 

A type of algorithm used to determine if a policy meets the 
requirements of the company. 

Universal: A collection of programs from all lines of business combined with result 
group mappings and assigned to execute in sequence that returns a 
single or multiple results. 

V 
Variable: A name used to represent a value that can change. See Variables in 

the Contents section for more information. 
Version: One of a sequence of copies of a program, each incorporating new 

modifications. See Versioning in the Contents section for more 
information. 

VFS Virtual File Servers. Virtual file server management allows you to set 
up servers that are in different locations where packages can be 
downloaded. 

W 
Wildcard: An option available for mapped variables that tells RateManager that 

one or more rows ignore the value passed in for the criteria. See 
Variables in the Contents section for more information. 

MultiLines: A MultiLines is a type of program that allows you to call multiple 
programs from different lines of business together under one universal 
program. 

Working Category: A classification used to define how elements should run. See 
Categories in the Contents section for more information. 

X 
XML ID: A number automatically assigned by RateManager to identify inputs 

and categories. 
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Index 

INDEX 

A 
Accessing 

Line of Business, 15 
Activated 

Line of Business Listing Screen, 17 
Activating 

Line of Business Listing Screen, 23 
ActiveX Controller, 10 
Adding 

Group, 48 
New Group in User Management, 47 
New User in User Management, 41 

Admin Rights, 74 
Administrator 

User Management, 39 
Administrator Group, 46 

Security Access, 46 
Allow Data Type Change 

Preferences, 77 
Assigning 

Group Rights, 53 
Assigning Group Rights, 52 
Audit 

Menu Bar, 26 
Audit Listing, 26, 40 
Audit Logs, 25 

Purging, 31 
Viewing, 26 

Audit Report, 30 
Audits, 26 
Creating, 30 
Details, 31 

Auditing 
Group Management, 49 
Groups, 49 

Audits 
Audit Report, 26 
Change Control, 29 
Deleting, 32 
Fields, 26 
Filter, 26 
Filtering, 28 
Purge All, 26, 32 
Refresh, 26 
Right Click Menu, 27 

Authoring Environment Definition, 88 

B 
Backup 

Deleting, 65 
Restoring, 64 
Storing, 63 
Success Message, 63 

Backup Share Folder Location 
Preferences, 76 

Batch Package Threads 
Preferences, 77 

Batch Results with New Line 
Preferences, 78 

C 
Cancel 

Group Management, 48 
User Management, 41 

Change Control 
Audits, 29 
Preferences, 78 

Change Password, 73 
Change Password Window, 73 
Changing 

Administrator Email, 77 
Company 

Selecting for New User, 41 
Contact Information 

Group Management, 56 
Create Backup, 63 

DB Backups, 62 
Creating 

Audit Report, 30 
Backups of Database, 61 
Database Snapshot, 62 

Custom 
Filter, 28 

Custom Lines 
Creating, 20 

Custom Type 
Line of Business Listing Screen, 17 

D 
Database 

Tools, 62 
DataBase 

Tools, 61 
Database Error Messages, 66 
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Database Snapshot 
Creating, 62 

Database Tab, 61 
Database Updates, 67 

Running, 68 
Tools, 70 
Viewing, 68 

Date Formats, 18 
DB Backups 

Create Backup, 62 
Delete Backup, 62 
Fields, 62 
Menu Bar, 62 
Refresh, 62 
Restore Backup, 62 

DB Updates 
Execute Update Script, 68 
Fields, 68 
Menu Bar, 67 
Open Update Script, 68 
Refresh, 68 
Save Update Script to File, 68 
Show Updates for, 68 

Deactivate License 
Session Mangement, 58 

Deactivating 
License, 58 
Line of Business Listing Screen, 23 

Deactivating User Session 
Session Management, 60 

Decimal Symbol, 19 
Default 

Groups, 46 
Locale, 17 

Default Proxy Script Location 
Preferences, 78 

Delete 
Group Management, 47 
User Management, 40 

Delete Audit, 27 
Delete Backup, 65 

DB Backups, 62 
Deleting 

Audits, 32 
Database Backup, 65 
Errors for a Group Delete, 54 
Group, 54 
Line of Business, 17 
User in User Management, 45 

Description 
Line of Business Listing Screen, 17 

Details 
Audit Report, 31 

Digit Grouping Symbol, 19 

E 
Edit 

Group Management, 47 
Line of Business Listing Screen, 16 
User Management, 40 

Edit Group Screen, 53 
Edit User 

User Management, 43, 44 
Editing 

Group, 53 
Line of Business Listing Screen, 22 
User in User Management, 43 
Web Config Settings, 74 

Editing Group Rights 
Example, 53 

Edition Notice, 2 
Email 

Changing Administrator, 77 
Enforce Release Packaging 

Preferences, 76 
Error Messages 

Database Backup, 66 
Errors 
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